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Visual Paradigm provides users with an open architecture to extend the functionality of Visual
Paradigm, which allows easy retrieval and modification of model data such as diagrams and model
elements, and the invocation of built-in functions. Users can develop plug-in, a set of one or more
functions written in Java, that adds features or services to Visual Paradigm.

In this tutorial, we are going to develop a plug-in that reads the flow of events of use cases and print
the collected information to an HTML file. We will use Eclipse as the Java IDE for implementing the
plug-in. Therefore, please get Eclipse ready. You can, however use any other Java IDE you preferred.

Gentting the Plug-in JavaDoc

The Plug-in JavaDoc provides Visual Paradigm plug-in developers with definition of classes,
attributes, operations and arguments in the plug-in. We recommend users getting the JavaDoc
and incorporating it into the Java project that will be created in the next section. To get the plug-in
JavaDoc:

1.  Visit the web page Plug-in API in Visual Paradigm official site.

2. Click on the link Download JavaDoc of Plug-in API.

- @Visual Paradigm Suite Plug-in API

"""" La odified: Aug 12, 2011
‘ Download JavaDoc of P l.gbn AP File Size: 11.1 MB

3.  Save the zip file to somewhere in your machine.

4.  Extract the zip file.

Implementing the Plug-in
1. Start Eclipse.
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2.  Create a Java project sample.genflowofevents.

-
= New Java Project

Create a Java Project

Create a Java project in the workspace or in an external location.

Project name:  sample.genflowofevents

Use default location

Checlipse\workspace\sample.genflowofevents

Tutorial

3. Inthe Java Settings page, set src to be the source folder and classes to be the class folder.

Default output folder:

sample.genflowofevents/classes]

4,

compiled.

Browse... ‘

-
= New Java Project

Java Settings
Define the Java build settings.

| [# Source I = Projects | =i Libraries |{>,|} Order and Export|

JARs and class folders on the build path:

> |low_openapi.jar - C:\Program Files (x86)\VP Sujte 5.2\lib | ’

Add JARS... ]

> B JRE Systern Library [JavaSE-1.6] L} ’

Add External JARs... |

l

Add Variable.. ]

5. Expand the node openapi.jar. Select Javadoc location.

| [ Source I = Projects| Eh Libraries |<}{} Order and Export|

JARs and class folders on the build path:
4 (a5 openapijar - C:\Program Files (86)\VP Suite 5.2\lib
@ Source attachment: (None)
@ Javadoc location: (Mone)
£ Native library location: (None)
;5% Access rules: (Mo restrictions)
> B JRE System Library [JavaSE-1.6]

6. Click Edit on the right hand side.
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Add JARs...
Add External JARs...
Add Variable...

Add Library...

Open the Libraries tab. The jar file openapi.jar in %VISUAL-PARADIGM-INSTALL-DIR%
\lib contains the API for plug-in development. Add it as a library or else your work cannot be
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7. Click Browse in the popup window. Input the path of the extracted zip of JavaDoc. Click OK.

= Javadoc For 'openapijar’ l SR X

@ Javadoc URL (e.g. 'http://www.sample-url.org/doc/” or file:/c:/myworkspace/myproject/doc’)

Javadoc location path:  file:/C:/Downloads/vp-plugin-javadoc/

8.  Click Finish in the New Java Project window.

9. Create a package sample.genflowofevents

r 1
= New Java Package l S| S|

Java Package
Create a new Java package.

Creates folders corresponding to packages.

Socurce folder:  sample.genflowofevents/src Browse...

MName: sample.genflowofevents

10. In package sample.genflowofevents, create a class GenFlowOfEvents which implements
interface VPPIugin. If you do this by Eclipse's code completion feature, two methods loaded
an unloaded will be added automatically. If not, add it yourself. If the editor cannot identify the
interface VPPIlugin, make sure you have added the openapi.jar to project build path.

[J] GenFlowOfEventsjava 5 =8

package sample.genflowofevents; -

import com.vp.plugin.VPPlugin;
import com.vp.plugin.VPPluginInfo;

public class GenFlowOfEvents implements WPPlugin{

£ public woid loaded(VPPluginInfo pluginInfo) {
¥

public void unleoaded() {
¥

11. Create package sample.genflowofevents.actions.

12. Inthe package sample.genflowofevents.actions, create a class
GenFlowOfEventsActionController which implements the interface VPActionController. This
class is made for performing certain action. In this case, it implements the logic of generating
flow of events to HTML report. The action can be triggered from user interface.
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13.

] GenFlowOfEvents.java [J] GenFlowOfEventsActionControllerjava 52 =8

package sample.genflowofevents.actions; -

import com.vp.plugin.action.VPAction;
import com.vp.plugin.action.VPActionController;

public class GenFlowOfEventsActionController implements VPActionC

public woid performéction(VPAction action) o

}

e public void update(VPActicon action) {

}

Here are some of the points you should be aware of:

1. The performAction() method contains the logic of action you want to perform.

2.  The update() method is called before showing the action on screen. You can make use of this
method to disable the method before it get shown. In this tutorial, we just leave it empty.

Let's fill in the method performAction(). First, we need to prompt user for the destination HTML
path. Enter the following code inside performAction():

/I get the view manager and the parent component for modal the dialog.
ViewManager viewManager = ApplicationManager.instance().getViewManager();
Component parentFrame = viewManager.getRootFrame();

/I popup a file chooser for choosing the output file
JFileChooser fileChooser = viewManager.createJFileChooser();
fileChooser.setFileFilter(new FileFilter() {

public String getDescription() {
return "*.htm";

}

public boolean accept(File file) {
return file.isDirectory() || file.getName().toLowerCase().endsWith(".htm");

}

D
fileChooser.showSaveDialog(parentFrame);
File file = fileChooser.getSelectedFile();

As we have incorporated the JavaDoc, we can read the description of class and methods when
using code completion.
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ProjectManager projectManager = ApplicationManager.instance().getProjectManager();

ItodelElementt[] models = pr‘ojectManager‘,getPr‘oject()‘mﬂ

@ toModelElementArray() : IModelElement[] - [Project
@ toModelElementArray(5tring modelType) : IModelElement[]
@ toModelElementArray(String[] modelTypes) : IModelElement

toModelElementArray
IMcdelElement[] toModelElementhArray (java.lang.Sty

Retrieve root level model elements from project

Parameters:

modelIype - type of model elements to retrieve
Returns:

root level model elements

4 n 2
Press "Ctrl=5pace’ to show Template Proposals

Press ‘Tab' from proposal table or click for focus)

Here are some of the points you should be aware of:

1. ViewManager is responsible for working with user interface. For example, you may call it to
print data to message pane.

2. Instead of initiating a File Chooser directly, we recommend you use
ViewManager.createJFileChooser instead.

14. After we have prompted the user for the path of HTML, we can proceed with retrieving the
flow of events of use cases and generating the data to HTML. Fill in the remaining part of the
performAction() method.

if (file!=null && !file.isDirectory()) {

String htmlContent ="";
String result =",

/I Retrieve all use cases from project
ProjectManager projectManager =
ApplicationManager.instance().getProjectManager();
IModelElement[] models =
projectManager.getProject().toModelElementArray(IModelElementFactory. MODEL_TYPE_USE_CASE);
/I Retrieve an HTML string of flow of events info from every use case
for (inti=0; i < models.length; i++) {
IModelElement modelElement = modelsi];
IUseCase useCase = (IlUseCase)modelElement;
htmlContent += generate(useCase);

}

I write to file
try {
FileWriter writer = new FileWriter(fileChooser.getSelectedFile());
System.out.printin(file.getAbsolutePath());
writer.write(htmlContent);
writer.close();
result = "Success! HTML generated to "+file.getAbsolutePath();
} catch (IOException e) {

}

https://lwww.visual-paradigm.com/tutorials/plugin.jsp Page 5 of 12



Visual Paradigm

How to Develop Visual Paradigm Plug-in?

15.
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}

/I show the generation result
viewManager.showMessageDialog(parentFrame, result);

Here are some of the points you should be aware of:

Tutorial

1.

ProjectManager.getProject().toModelElementArray(IModelElementFactory. MODEL_TYPE_USH

enables you to get an array of specific type of model element, such as use case.

IModelElementFactory contains constants of element type names

IModelElement refers to a model element in project, such as a use case, an actor, etc.

You may type-cast an IModelElement into a concrete type class, such as IlUseCase, |Actor,

etc.

Add and implement another method generate(), which takes IlUseCase as parameter, prepares
the HTML string and returns the result back to the method that calls it.

public String generate(lUseCase useCase) {
String content = ";

/I Retrieve flow of events sets from use case. Each IStepContainer is a set
of flow of
events
IStepContainer[] stepContainers = useCase.toStepContainerArray();
for (inti = 0; i < stepContainers.length; i++) {
IStepContainer stepContainer = stepContainersJi];

/I Print the name of use case and flow of events to HTML string
content += "<table border=\"1\" width=\"500\"><tr><th>" +
useCase.getName()
+ " - "+ stepContainer.getName() + "</th></tr>";

/I Print the flow of events content to HTML string
IStep[] stepArray = stepContainer.toStepArray();
for (intj = 0; j < stepArray.length; j++) {
IStep step = stepArray[j];
content += "<tr><td>"+ (j+1) + ". " + step.getName()+"</td></tr>";

content += "</table><br>";

return content;

Here are some of the points you should be aware of:
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1. IStepContainer refers to a set of flow of events. Each use case can have zero or more than
one set of flow of events.

2.  IStep refers to a step (i.e. a row) inside a flow of events set.

16. The coding part is done. If you find the code cannot be compiled, please make sure you have
added openapi.jar into the build path.

Deploying the Plug-in
1. Create an XML file plugin.xml under the project root.

[ Package Explorer 53 =08
B8 e~
4 = sample.genflowofevents
4 [ src

4 i} sample.genflowofevents
» [J] GenFlowQfEvents.java
4 i} sample.genflowofevents.actior
» [J] GenFlowOfEventsActionCo
> E, JRE System Library [JavaSE-1.6]
4 = Referenced Libraries
. s openapijar - C:\Program Files |
%] plugin.xml

2.  Fill in the XML file as shown below:

<plugin
id="sample.genflowofevents"
name="Generate Flow of Events Report"
description="Generate an HTML report of use case flow of events."
provider="Visual Paradigm"
class="sample.genflowofevents.GenFlowOfEvents">
<actionSets>
<actionSet id="sample.genflowofevents.actionset">
<action
id="sample.genflowofevents.actions.GenFlowOfEventsActionController"
actionType="generalAction"
label="Generate Flow of Events Report"
tooltip="Generate Flow of Events Report"
style="normal"
menuPath="Tools/Report"&gt
<actionController
class="sample.genflowofevents.actions.GenFlowOfEventsActionController"/>
</action>
</actionSet>
</actionSets></plugin>

Here is a description of the content of plugin.xml:
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% pluginxml 2

<plugin
———id="sample.genflowofevents”
name="Generate Flow of Events R:‘port"——@
@- use flow of events.™

=description="Generate an HTML rt of
provider="Visual Par‘adigm"——@
class="sample.genflowofevents. LowOvaents">——®
<actio

nsets>
i ctionSet id="samp|'.e.genfn‘.owof&vents.actioﬁset”>—-®

= cgction
id="sample.genflowofevents. acti=s .G:‘nFn'.owaEv:‘ﬁts.flctf.onContrm‘,Ler"——
actionType:"g:‘ﬁerm‘,.ﬂction"—

—1abel="Gener‘ate Flow of Event. port"
tooltip="Generate Flow of Events Report”--@

@————style="normm‘."

rrenuPath:"Tom',s/’Report">—-®
<actionController

class="sample.genflowofevents. actions. GenFlowdfEventsActionController” />
<faction>

</actionset>
</actionSets» 0
</plugin>

No.

Description

A text for identifying this plug-in. You may develop multiple plug-ins. Each plug-in must have a
unique id defined.

The name of plug-in.

The description of plug-in.

The person/organization who develop this plug-in.

The fully qualified class name of the plug-in class, which is the class that implements the
VPPIugin class, offering the load and unload logic.

Actionsets describe the possible ways of invoking the plug-in. An action can be added
into MenuBar and Toolbar, by setting @menuPath=... and @toolbarPath=... If your
plugin have actions on menu bar and diagram's popup menu. For menu bar's actions,
the actions are defined in <actionSet>; For toolbar's actions the actions are defined in
<contextSensitiveActionSet>.

A unique value for identifying the action set.

A unique value for identifying the action.

Define the type of action: [generalAction | shapeAction | connectorAction].

generalAction: The simple action that may be added on menu bar/toolbar/diagram popup
menu. You are required to specify the <actionController...> for this action (ref to point 14).
shapeAction: The action used to create CustomShape. You are required to specify the
<shapeCreatorinfo...>

connectorAction; The action used to create CustomConnector. You are required to specify a
set of <connectionRule...>

10

The menu item text.

11

Tooltip is the text that display when moving mouse pointer over a toolbar button.
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12 | Specify the menu item is Normal button or Toggle (Checkbox) button. [normal | toggle]

13 | The position where the menu/toolbar button will be presented. In this case, the menu will be
placed under the Tools menu, after the menu Report.

what and how to perform the action.

14 | The fully qualified class name of the class that implements VPActionController, for showing

3. It'stime to deploy the plug-in into your Visual Paradigm installation, to make it available in Visual
Paradigm. Create a folder plug-ins in the Visual Paradigm installation folder. (E.g. C:\Program

Files\Visual Paradigm\plugins)

(550 | S
@@v| , <« Progra.. » VP Suite5.2 » - |¢f| | Search VP Suite 5.2 0 [
Organize » 7 Open Include in library + Share with = » B= 0l @

launcher lib

File folder File folder

ormlib plugins L\\)

File folder [ File folder

FESOUrCes Samples

File folder File folder

4.  Copy the Java project folder sample.genflowofevents into the plugins folder. You should obtain
folder structure like this: C:\Program Files\Visual Paradigm\plugins\sample.genflowofevents

\classes.

sample.genflowofevents
| File folder

Running the Plug-in

=) e |
@-u-v| , <« VP 5Suite 5.2 » plugins » A4 |+,| | Search plugins o
Organize » = Open Include in library + Share with + 2 B 0l @

1. Create a new project in Visual Paradigm by selecting Project > New from the application
toolbar. In the New Project window, enter Test Plug-in as project name and click Create Blank

Project.
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2. Draw a simple use case diagram with 2 use cases Post Topic and Reply Topic, like this:

Post Topic

Wisitor

Raply Topic

vi

3. Right-click on the use case Post Topic and select Open Use Case Details... from the pop-up
menu.

- 2

Open Specification... Enter
Stereotypes 3
@ Model Element Properties »
Open Use Case Details... L\\,

G Use Case Scheduling...

Sub Diagrams 3

4.  Open the Flow of Events tab. Enter the steps: 1. Click [New Post], 2. Enter the contents, 3.
Click [Submit]
Info | Flow of Events | Details I Requirements I Diagrams I Test Plan I References I Descripﬁonl
Fonotevens | -, | 4| @ | F,iE| A V| EE =0 4]
1. Click [New Post]
2. Enter the contents
3. Click [Submit]]
5.  Atthe top right of flow of events, click the Next button to move to the use case Reply Topic.

¢ =l (2)3]

:(Hide testing procedures) -

6. Enter the flow of events for use case Reply Topic: 1. Open a post, 2. Click [Reply], 3. Enter the
contents, 4. Click [Submit]

Info | Flow of Events | Details I Requirements I Diagrams I Test Plan I References I Descripﬁonl

+|@ FEAVEE wwo |

:Flow of Events « 3

. Open a post

. Click [Reply]

3. Enter the contents
. Click [Submit]

(O]

&
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7. Let'stest our plug-in. Select Tools > Generate Flow of Events Report from the main menu.

File Edit View | Tools | Window Help

[E Lffb @ Report 3 (6
Project T Print i Generate Flow of Events Report L\@ s i Dotabase "
E" @ I.:-"'_.\ Project Publisher... @
Diagram Navigator Project Management Look-ups...

8.  You are prompted for the output path of the HTML. Specify the file path in Save window and
click Save. The HTML file will be saved to the specified location.

@ Mozilla Firefox

File Edit Miew History Bookmarks Tools Help

€& .I = | || file:///Cfoutput/sample.htm

| |_| filew//fC:/output/sample.htm x |T|

| Post Topic - Flow of Events
|1. Click [New Post]

|2_ Enter the contents

3. Click [Submit]

| Reply Topic - Flow of Events

|l_ Open a post

2. Click [Reply]

|3. Enter the contents
4. Click [Submit]

Resources
1. Java Project (folder) of this plug-in

Related Links
. Debug your plug-in with Eclipse

. Visual Paradigm Plug-in User's Guide

. Visual Paradigm Plug-in Sample
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Visual Q Paradigm
A\ 4

Visual Paradigm home page
(https://www.visual-paradigm.com/)

Visual Paradigm tutorials

(https://www.visual-paradigm.com/tutorials/)
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